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1.0 Welcome to Sugar Open Source 

 
Thank you for using Sugar Open Source, created by SugarCRM Inc. The Sugar Open Source edition 
is designed to help you enable your organization to efficiently organize and maintain information 
which is crucial to many aspects of your business.  
 

• Sugar Open Source provides integrated management of corporate information on customer 
accounts and contacts, sales leads and opportunities, plus activities such as calls, meetings, 
and assigned tasks.  

 
• The system also offers a graphical Dashboard to track your sales pipeline, the most 

successful lead sources, and the month-by-month outcomes for opportunities in the pipeline. 
 
Most importantly, the system seamlessly blends all of these capabilities into an intuitive and friendly 
tabbed interface.The instructions in this guide will introduce you to some basic Customer 
Relationship Management (CRM) concepts and help you get familiar with the fundamentals of using 
your Sugar Open Source system.  
 
Sugar is an open source project, and as such, advances quickly through the development and 
contribution of new features by its entire supporting community, of which SugarCRM Inc., The Long 
Reach Corporation, and many other organizations and individuals are proud to be a part. Welcome to 
the community! 
  

1.1 About this Guide 
 
This guide is current with the details of operation for Sugar Open Source 3.0. It is designed for users 
who are new to Sugar Open Source, or the areas of customer relationship management and web-
based applications. The information in this guide describes how to use a personal computer and a 
web browser to access Sugar Open Source to perform a broad range of corporate information 
management tasks.  
 
Readers are not required to have any programming or software development knowledge, but should 
be generally familiar with the use of a personal computer and Internet browser software, such as 
Microsoft Internet Explorer or Mozilla Firefox. 
 

1.2 Who Should Read this Guide? 
 
This Sugar Open Source User Guide provides information primarily for users who want to record and 
track company activities and outcomes. It contains additional notes and topics specifically for 
administrators who manage user access to the system. 
 
This guide is not intended for system administration personnel who need to install and configure the 
system as part of its initial implementation.  
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2.0 About Sugar Open Source 

 
Sugar Open Source enables organizations to efficiently organize, populate, and maintain information 
on all aspects of their customer relationships. The system seamlessly blends all of the functionality 
required to manage information on many aspects of your business into an intuitive and friendly 
tabbed user interface. 
 
The core features of Sugar Open Source include: 

Customer Relationship Management:  
• Account creation and management, with any number of Contacts associated with each 

Account; 
• Activity history (Meetings, Calls, Tasks, Notes with optional file attachments, and Emails) is 

tracked for Contacts, Accounts, Leads, Opportunities and Cases;  
• Tasks may be assigned to users, and automatic email notifications may optionally be sent to 

advise users of new tasks; and 

Sales Force Automation:  
• Summary view of upcoming Appointments, top Opportunities, open Cases, Leads, open 

Tasks, assigned Bugs, sales pipeline graph, monthly calendar, and a quick contact entry 
facility; 

• Sales Lead creation and tracking, and conversion of sales Leads into Opportunities; and 
• Graphical Dashboard display of Opportunity Pipeline, Lead Sources & Outcomes. 

Customer Service Tracking:   
• A case management system that allows users to track customer problems and resolutions. 

Allows each problem to have a lifecycle of information to improve customer satisfaction; and 
• Each case links to the related Account, Contacts, Notes, associated files, plus Call and 

Meeting activity history. 
• A bug tracking system for managing bugs reported against different revisions of software. 

News Service:   
• An RSS news feeds module lets you select and manage your favorite news feeds, and 

display them on your My RSS News Feeds screen.  

Corporate Calendar:   
• Calendar view (by Day, Week, Month, or Year) of all corporate Activities, with an associated 

Task list; and 
• Shared calendar for viewing other user’s calendars for avoiding scheduling conflicts. 

Interface Consolidation:   
• The Portal module allows administrators and users to link external web sites and web 

applications into the Sugar Suite user interface, enabling Sugar Suite to become a unified 
information interface for its users.  

Sugar Open Source is built on established open-source technologies and widely supported industry 
standards, including the PHP development environment, the MySQL relational database, the Apache 
or IIS web servers, and the Linux or Windows Server operating systems. The system supports both 
the LAMP (Linux, Apache, MySQL, PHP) and WIMP (Windows, IIS, MySQL, PHP) platforms. 
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2.1 What’s New in this Version? 
 
With each revision of the Sugar Open Source software, significant advances are made in both the 
feature set and usability of the software. Here are some of the highlights of version 3.5 of the 
software, as compared to the previous version, 3.0. 
 
Module Loader: 
Administrators can easily load and unload custom modules into the current installation.  
 
Upgrade Wizard: 
Administrators can easily upgrade full installations, patches, language packs and custom themes by 
uploading specific .zip files. The Upgrade Wizard manages the rest of the tasks for you. 
 
Formatting in Email Module: 
When creating email and email templates, an HTML formatting toolbar provides all the standard 
formatting options for fonts, size, color, and style. Additional buttons insert rules, hyperlinks, pictures, 
table and display the HTML source code. 
 
Improved Sub-panels: 
Sub-panels for modules include sorting and paging in lists and the collapsing of sub-panels for easier 
viewing capabilities. 
 
History Summary View: 
For modules that include a History sub-panel, users can click the Summary button to view history at 
a glance instead of clicking on each item for details. 
 
View Change Log Link: 
The View Change Log link displays the history of changes for the fields that track changes. The 
following modules contain fields tracked in the Change Log: Contacts, Accounts, Leads, 
Opportunities, Quotes, Products, Cases, Bug Tracker, Campaigns, Projects (Tasks). 
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3.0 Getting Started with Sugar Open 
Source 

 

3.1 Before You Start 
 
This guide assumes that the resources you need to access the system are available and that you are 
familiar with how to use them. If you are not sure whether your system meets the requirements or 
how to use required third-party tools, such as a web browser, talk to your manager or system 
administrator.  
 

3.1.1 Technical Requirements 
 
Before you begin using the system, ensure that you have the required software installed and 
configured on your system. You will require the following: 
 

• A current web browser running on your computer. 

Sugar Open Source has been tested with and supports a variety of browsers. The following 
browsers are known to work with Sugar Open Source: 

o Mozilla version 1.7 and higher - www.mozilla.org/mozilla1.x 

o Firefox version 1.0 and higher - www.mozilla.org/firefox 

o Konqueror version 3.2 and higher - www.konqueror.org 

o Microsoft Internet Explorer version 5 and higher - www.microsoft.com/ie 

You may encounter problems if you try to access Sugar Open Source using older web 
browsers such as Internet Explorer 4 or Netscape 4.x. If you are unsure about which web 
browser version you are using, click Help > About or similar options on the menu bar in your 
browser. The version number displays. 

• JavaScript and cookies support enabled in your web browser. 

Both JavaScript and cookies support must be enabled in the security settings of your 
browser and is usually turned on by default. 

If you encounter problems accessing the system, check your browser configuration to ensure 
both JavaScript support and cookies support are enabled. Click Tools > Internet Options > 
Privacy and Security tabs in Internet Explorer, or Tools > Options > Privacy and Web 
Features tabs in Firefox. 

• Network access to a server that is running the Suga r Open Source software. 

Your system or network administrator can provide you with an Internet address (URL) from 
which the system can be accessed.  
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Web Browser and Window Controls 

 
Sugar Open Source dynamically creates the HTML screens displayed 
by the web browser when you click certain buttons in the web pages. 
 
Using the web browser’s Back and Forward buttons can cause 
problems displaying these dynamically generated pages. For this 
reason, it is not recommended to use these controls on your browser 
when using Sugar Open Source. 
 
Sugar Open Source is designed for a minimum 1024x768-pixel screen 
display resolution. 
 

Log In Information 

 
Your system administrator assigns log in information – a user name and password – to every system 
user. If you have not received your user name and password combination, contact your system 
administrator. 
 
If you do not provide the correct user name and password, Sugar Open Source does not allow you 
access to the system. 
 

3.2 Accessing Sugar Open Source  
 
To access Sugar Open Source, type the URL into your web browser’s address bar. A screen 
displays, similar to the one shown in Figure 1.  
 

 

Figure 1: The Sugar Open Source Log In Screen 

Tip 
Hold down the CTRL key in 
Mozilla Firefox or the Shift 
key in Windows Internet 
Explorer while clicking on a 
link to open a new browser 
window when navigating 
throughout the application. 
This is an especially useful 
navigation technique when 
viewing many records in a list 
view or in a report. 
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This is the Sugar Open Source log in screen. If you do not see a log in screen, verify that you have 
typed the URL correctly, or contact your system administrator to verify that you have the correct URL. 
To proceed, you must log in to the system by providing a valid user name and password.  
 
You may also choose the language that you want to use when working in the system and the theme 
or visual appearance you want the system to have. Languages and themes can be found at 
http://www.sugarcrm.com/home/Download_Sugar_Sales/107/. 
 

Logging in to the System 

 
To log in to the system: 

1. In the Sugar Open Source log in screen, type your user name in the User Name box. 

2. Type your password in the Password box. 

3. Select the language and theme that you want to use (if applicable). 

4. Click the Log In button. 

 
If you cannot log in, check the following: 

• Verify that your user name and password were typed correctly, 
including any capital letters.  

• Contact your system administrator to verify that you have the 
correct user name and password combination. 

• Your account may have been disabled. Contact your system 
administrator. 

 

3.2.1 Security Timeout 
 
For security reasons, the system automatically logs you out of the system if you do not perform any 
tasks for a period of time. By default, the system does not log you out until 30 minutes have elapsed 
without any activity. (This feature can be turned off, or the time period changed, via PHP 
configuration parameters.) 
 
When you are ready to resume working with the system, click any button on the screen. The system 
automatically loads the log in page for you. You can also close the web browser windows and re-load 
the log in page manually in a new browser window. 
 

3.3 Managing Your Password 
 
When you are first given access to the system, your administrator will provide you with a password. 
For security reasons, you should change this password to another one that only you know. Ensure 
that you choose a password that is easy for you to remember, but difficult for another person to 
guess. 
 
You can change your password at any time. It is a good idea to change your password occasionally. 

Tip 

System passwords 
are case sensitive. 
“John differs from 
“john”. 
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Changing Your Password 

 

To change your password: 

1. Click the My Account link (see highlighted item 1, on Figure 2 
below) that appears at the top right of your screen whenever you 
are logged in to the system.   

2. On the My Account screen, click on the Change Password button (see highlighted item 2, on 
Figure 2 below).  

3. In the Change Password dialog box which appears, type your new password in the New 
Password box, and again in the Confirm Password box. 

4. Click the Save button. 
 
If you forget your password, you must contact your system administrator, who will reset it to a value 
which you can use temporarily. You should then log in to the system, and change the password to 
another value of your own choosing, according to the procedure described above.  
 

 

Figure 2: The ‘My Account’ Screen 

Tip 

System passwords 
must be at least 6 
characters long and 
contain at least 1 
numeric character. 

1 

2 
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3.4 The User Interface 
 
When you log into the system, the Home tab displays, as shown below in Figure 3. Various key 
elements of the screen layout are highlighted on Figure 3, as follows: 
 

1. Navigation Tabs: Click to choose a module to display. A dropdown menu lets you select 
other modules if you have more than 12 tabs. 

2. Navigation Shortcuts Box: Specific shortcuts useful within each module  
3. Last Viewed: A useful trail of recent records you have viewed 
4. Search Box: Search for a text string within key data held by Sugar Open Source  
5. System Links: My Account, Employees, Logout, and About. The Admin link is only available 

to users defined as administrators 
6. Quick New Item Box: Quick data entry box to create a new item for the current module 
7. Main Screen Body: On the Home tab, this includes Cases, Opportunities, Appointments, 

Leads, Tasks, monthly Calendar and Pipeline graph.  
 

 
Figure 3: The Home Tab Screen 

 
The screen layout in the Home tab uses the same layout as all of the other tabs. As you move 
between the tabs, the shortcuts change according to the specific tab, and the main screen body 
displays the information indicated by the tab name. The Quick New Item box changes to offer quick 
access for creating new items based on the tab, for example, New Contact, New Account, New 
Opportunity, and so on.  
 

1 

2 

3 
4 

5 

6 

7 
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3.4.1 Modules 
 
From the Home tab, you can access any module by clicking on the tab 
related to its name. Modules help you work more efficiently by grouping 
the tools and functions you need to perform specific tasks. Some 
themes display the modules as links on the left side of the user 
interface instead of tabs. This document refers to the tabbed interface.  
Sugar Open Source consists of the following modules:  
 

1. Home  

The Home tab contains a general overview of Cases, Opportunities, Appointments, Leads, 
Tasks, Calendar and Pipeline. It also includes shortcuts to enter most sorts of data, and a 
quick form for new contacts. The Home tab provides a quick overview of what customer 
tasks and activities you need to focus on today. 

2. My Portal  

My Portal contains a series of shortcuts which can link to any web site you choose. This is 
commonly used to include email, forums, or any other web-based application, allowing Sugar 
Open Source to become a single user interface for multiple applications. 

3. Calendar  

View scheduled activities (by day, week, month or year), such as meetings, tasks, and calls. 
Being able to share your calendar with your coworkers is a powerful tool for coordinating 
your daily activities. 

4. Activities  

The Activities tab allows you to create or update scheduled activities, or to search for existing 
activities. By managing Activities within the context of an Account, Contact, Lead, 
Opportunity, or Case, the true value of Sugar Open Source becomes apparent. Sugar Open 
Source allows you to manage the myriad of calls, meetings, notes, emails and tasks that you 
need to track in order to get your job done. 

• Tasks are for tracking any action that needs to be managed to completion by a due 
date. 

• Notes allow you to capture note information as well as upload file attachments. 

• Calls allow you to track all of your phone calls with leads and customers. 

• Meetings are like calls, but also allow you to track the location of the meeting. 

• Emails allow you to archive sent or received email messages. If you use Microsoft 
Outlook, you can quickly archive email messages with the Sugar Plug-in for Outlook. 

5. Contacts  

View a paginated contact list, or search for a contact. You can click on a specific contact to 
zoom in on the detailed contact record. From a specific contact record, you may link to the 
related account, or leads, opportunities, cases, or direct reports (related contacts). 

Contacts are the people with whom your organization does business. As with accounts, 
Sugar Open Source allows you to track a variety of contact information such as title, email 
address, and other data. Contacts are usually linked to an Account, although this is not 
required. 

Tip 

Not every module has a 
screen tab. For instance, the 
Notes, Emails, Tasks, Calls, 
and Meetings modules are 
all grouped together in the 
Activities tab. 
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6. Accounts  

View a paginated account list, or search for an account. You can click on a specific account 
to zoom in on the detailed account record. From a specific account record, you may link to 
related contacts, activities, leads, opportunities, cases, or member organizations. 

Accounts are the companies with which your organization does business. Sugar Open 
Source allows you to track a variety of information about an account including website, main 
address, number of employees and other data. Business subsidiaries can be linked to parent 
businesses in order to show relationships between accounts. 

7. Leads  

View a paginated list of leads, or search for a specific lead. You can click on an individual 
lead to zoom in on the lead information record. From that detailed lead record, you can link 
to all related activities, and see the activity history for the lead. 

Leads are the people or companies with whom your organization might do business in the 
future. Designed to track that first point of interaction with a potential customer, leads are 
usually the hand off between the marketing department and the sales department. Not to be 
confused with a contact or account, leads can often contain incomplete or inaccurate 
information whereas contacts and accounts stored in Sugar Open Source are core to many 
business processes that require accurate data. Leads are typically fed into the Sugar Open 
Source system automatically from your website, trade show lists or other methods. However, 
you can also directly enter leads into Sugar Open Source manually. 

8. Opportunities  

View a paginated list of opportunities, or search for a specific opportunity. You can click on 
an individual opportunity to zoom in on the opportunity information record. From that detailed 
opportunity record, you can link to all related activities, see the activity history for the 
opportunity, and link to related leads and contacts.  

Opportunities track the process of selling a good or service to a potential customer. Once a 
selling process has commenced with a lead, a lead should be converted into a contact and 
possibly also an account. Opportunities help you manage your selling process by tracking 
attributes such as sales stages, probability of close, deal amount and other information. 

9. Cases  

View a paginated list of cases, or search for a specific case. You can click on an individual 
case to zoom in on the case information record. From that detailed case record, you can link 
to all related activities, see the activity history for the case, and link to related contacts. 

Cases are the handoff between the sales department and the customer support department. 
Cases help customer support representatives manage support problems or inquiries to 
completion by tracking information for each case such as its status and priority, the user 
assigned, as well as a full trail of all related open and completed activities. 

10. Bug Tracker  

View a paginated list of reported software bugs. You can click on an individual bug to zoom 
in on the detailed bug report. From that detailed bug report, you can link to all related 
activities, see the activity history for the bug, and link to related Contacts, Accounts, and 
Cases. 

Tracking software bugs is an important function of a customer support department. The Bug 
Tracker module helps customer support representatives manage software-related support 
problems or inquiries to completion by tracking information for each bug such as its status 
and priority, its resolution, the user assigned, the release of software involved, its type 
(defect or feature) as well as a full trail of all related open and completed activities. 
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11. Documents  

The Documents tab shows you a list of documents that you can download. You can also 
upload your own documents, assign publish and expiration dates, and specify which users 
can access them. 

12. Emails  

The Emails tab allows you to write and send emails and to create Email Templates that can 
be used with email-based marketing campaigns. You can also save drafts and archived 
emails. 

13. Campaigns  

The Campaigns tab helps you implement and track marketing campaigns. Campaigns may 
be telemarketing, mail or email based. For each Campaign, you can create the Prospects list 
from your Contacts or Leads or outside file sources. 

14. Projects  

The Projects tabs helps you manage tasks related to specific projects. You can track and 
manage tasks for a project. Tasks can be assigned to different users and assigned estimated 
hours of effort. As tasks are in progress and completed, users can update the information for 
each task. 

15. RSS 

View the latest headlines provided by your favorite RDF Site Summary (RSS) feeds. These 
feeds provide news or other web content that is distributed or syndicated by web sites which 
publish their content in this manner. The system has hundreds of RSS feeds available as 
supplied, and others may easily be added.  

Yahoo, ZDNet, Wired, Slashdot, Washing Post, The Telegraph, The Seattle Post, Reuters, 
New York Times, InfoWorld, Boston Globe, CBS MarketWatch, ABC News, BBC News – you 
can make them available to create your own custom news-gathering experience.  

16. Dashboard  

The Dashboard tab displays a graphical dashboard of your Opportunity Pipeline by Sales 
Stage, Opportunities by Lead Source by Outcome, Pipeline by Month by Outcome, and 
Opportunities by Lead Source.  

 

Selecting a Module 

 
To select a module when the Home tab displays:  

• Click on the tab which shows the name of the module you want to 
use. 

 

3.4.2 Navigating the Module Screens 
 
All of the Task module screens use the same basic layout – making it easy for you to move from one 
area of the application to the next. Figure 3 shows the Sugar Open Source screen with the Home tab 
as the selected Task module.  
 

Tip 

The Module tab list is 
always available at the 
top of the browser 
window. Click one of 
the tabs in this list to 
switch modules. 
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3.4.3 List View Screens and Searching 
 
Most module screens (Home, Calendar and Dashboard are exceptions) have two key elements to 
them – a search filter capability at the top, and a list view of items below. As an example, look ahead 
to Figure 10, the Accounts module. Generally, the search filter has basic search fields, and a link to 
use the advanced search with more fields on which to filter the list of items below. You can see this 
Advanced link on Figure 10, on the right hand side of the Account Search area. 
 
When working with the list view, you can work with the complete list, or use the search filter to reduce 
it to a more manageable size. To use the search filter, type in one or more boxes, and click on the 
Search button. Text entered in search fields needs to match from the beginning of the value stored in 
each record – for example “fred” will match Frederick, but not Alfred, in a first name field. If text is 
entered in more than one search field, then a record must match on all those fields to be included in 
the filtered list. Wild card search characters are not needed and not supported. In other words, 
searching for “fred*” would only match first names like “Fred*erick” or other “Fred” names containing 
the asterisk (*) character. 
  
Using the system level search box (highlighted item 4 on Figure 3 above) is much the same, only it 
searches Contacts, Accounts, Leads, Opportunities and Cases, and looks for search text to match 
from the beginning of key fields for each, as below. Note: numeric search strings will match 
anywhere in a field. Then all matching records are displayed in a series of paginated lists.  

Contacts:  First Name, Last Name, Email, Other Email, Home (phone), Mobile (phone), Office 
Phone, Other Phone, Fax, Assistant, Assistant Phone  

Accounts:  Account Name, Phone, Other Phone, Fax 

Leads:  First Name, Last Name, Account Name, Email, Other Email, Home (phone), Mobile (phone), 
Office Phone, Other Phone, Fax 

Opportunities:  Opportunity Name 

Cases:  Case Number, Subject 
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3.4.4 Detail View Screens 
 
From a module’s list view, clicking on any entry in the list displays the detail view for that item – for 
example the full details of a contact, or an account. This detail view shows more information than the 
list view for the specific item selected. It also shows all associated items of information, and lets you 
click on links to them. For example, the Accounts detail view screen lists all associated Account 
Open Activities, History (Notes, Emails, Tasks, Meetings, and Calls), Contacts, Opportunities, Leads, 
Cases, Member Organizations and Bugs. These lists of related information are called sub-panels. 
 
This listing of associated items as sub-panels is really the fundamental power of the Sugar Open 
Source system – the system associates and represents information in much the same way that your 
brain thinks, and lets you navigate or explore the information that way. Figure 4 below shows a 
sample detail view screen with the Open Activities, History, Contacts, Opportunities, Leads, Cases, 
Member Organizations and Bug Tracker sub-panels. You can click arrows to sort columns and page 
through lists and you can click buttons next to sub-panel headers to collapse or display subpanels.  
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Figure 4: The Account Detail Screen 
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3.4.5 Printing and Help 
 
Each module provides  Print and  Help icons on the title bar at the top of the main screen body. 
Click the Print icon to print the current screen view. Clicking the Help button displays a link to the 
latest user documentation. 
 

3.5 Logging Out of the System 
 
When you are finished working with the system, you should always log out of the system rather than 
just closing your web browser. 
 
When you log out, the system performs several ‘clean-up’ procedures, and then automatically returns 
the web browser window to the Login screen.  
 
To log out: 
 

1. Click the Logout link in the User Management area (see item 5, Figure 3), in the top right 
hand area of the screen. 

2. Close the browser window. 
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4.0 Using Sugar Open Source 

 

4.1 The Portal Module 
 
Figure 5 shows the Sugar Open Source screen with the Portal module selected using the My Portal 
navigation tab:  
 

 

 
 

Figure 5: The Portal Module 
 
The My Portals screen provides shortcuts to web sites or applications. You can create shortcuts to 
web sites so that they appear as a set of shortcuts on the My Portal screen. Administrators can also 
add shortcuts to the list in the My Portal tab and they can create additional Portal tabs. New tabs are 
often used for email, forums, or other web-based applications, which allows Sugar Open Source to 
provide a single interface for multiple application purposes. The initial web site displayed when you 
click the My Portals tab is the Portal home site, which is configured by the Administrator. 
 
A set of shortcuts allows you to Add Site, List Sites, or to navigate to sites with shortcuts already 
created. The shortcuts include shortcuts you created to view Personal sites and shortcuts to Global 
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sites created by the Administrator. To display the Portal screen list, click the List Sites shortcut. To 
delete a Portal site from the Portal List screen, click the checkbox next to the site and then click the 
Delete button below the list of Portal sites. You can also edit a Portal site by clicking on its name. To 
view its target web site, click the link to the URL. 
 
To create a new Portal site, click the Add Site shortcut. When creating a new Portal site, you can 
type the name and web site, click to select if you want it to be currently visible or not. You might want 
to hide shortcuts without deleting them from the list. You can select whether the shortcut displays in 
the shortcut list, on the tab menu, or both. Administrators can select whether the site is Personal or 
Global. Global means that the shortcut is added for all users. 



Sugar Open Source User Guide 
 

 
Section 4: Using Sugar Open Source     Page 23 

4.2 The Calendar Module 
 
Figure 6 shows the Sugar Open Source screen with the Calendar module selected using the 
Calendar navigation tab:  
 

 
Figure 6: The Calendar Module (Month Format) 

 
You can display your calendar by Day, Week, Month or Year by clicking on the buttons at the top left 
of the main screen. Month format is shown in Figure 6 above, and Day format in Figure 7 below. In 
each format, any planned activities with associated dates are displayed – such as Calls, Meetings, 
Tasks, Notes and Emails. Icons are used to indicate the type of activity:  for a Call,  for a Task, 
and  for a Meeting. You may click on any activity in your calendar to edit that activity.  
 
Each different display format allows you to nudge backwards and forwards in time - by one day, 
week, month or year. In the Week, Month or Year display formats, clicking on a particular date within 
the display shifts the display to Day format for that date.  
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Figure 7: The Calendar Module (Day Format) 

 
The Day display format has the hours of the day listed vertically. Clicking on a specific time displays 
a quick method of scheduling a Call or Meeting, as shown in Figure 7 above.  
The Day display format also includes a task list on the right side of the main screen body. Click the 
subject of a task in the list to view the details of that task. 
 
The shortcuts allow you to view Calls, Meetings and Today. You can also click a shortcut to schedule 
a meeting or call. When you click the Schedule Meeting shortcut, you can view the meeting time slot 
in graphical view of the day. If other calls or meetings are scheduled, the busy time displays as 
blocked out. You can invite other users to the meeting by searching by their names and adding them. 

 
Figure 8: The Calendar Module (Schedule Meeting) 
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4.3 The Activities Module 
 
Figure 9 shows the Sugar Open Source screen with the Activities module selected using the 
Activities navigation tab:  
 

 
 

Figure 9: The Activities Module (Task List View) 
 
The Activities module allows you to create a new Call, Meeting, Task, Note or Email, by using 
shortcuts in the navigation shortcuts box. As well, you may select different list views for Calls, 
Meetings, Tasks, Notes or Emails, using the navigation shortcuts box. Figure 8 illustrates the Task 
List view mode. Each of the list views typically provides a list of all or selected items from a recent 
search. Each item in the list has a check box at the left, and at the bottom of the screen is a facility to 
update one or more field values for all checked items.  
 
Each list may be sorted by clicking on any column title which has the  icon beside it. Clicking on a 
column title when it is already the highlighted sort column reverses the sort order. Each list is 
paginated if it contains more items than may be listed on the display, and controls are provided to go 
to the start or end of the list, or step to the next or previous page.  
 
Each of these list views provides powerful linking capabilities to related information. The Task List 
view, for example, lists Subject, Contact, Related To, Due Date, and the user assigned to the task. 
Clicking on a task’s subject takes you to a detailed view of the specific task. Clicking on the Contact 
zooms to a detailed view of that contact, and so on. This is the real power and elegance of the Sugar 
Open Source user interface. You can also click Import Notes to import notes from an outside file 
such as a .csv or .tsv file or from Salesforce.com. 
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4.4 The Contacts Module 
 
Figure 10 shows the Sugar Open Source screen with the Contacts module selected using the 
Contacts navigation tab:  
 

 
Figure 10: The Contacts Module 

 
Contacts are people related to sales accounts. The Contacts module provides a list of all or selected 
Contacts from a recent search. Each Contact in the list has a check box at the left, and at the bottom 
of the screen is a facility to update one or more field values for all selected Contacts. 
 
The Contact list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Contact list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
Contact in the list displays the detail information for that Contact. You can edit or view information 
about the Contact. Click the View Change Log link to view the old and new values for fields that track 
changes. The tracked fields include Assigned User, Team, Do Not Call flag, Office Phone, and Email. 
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In the History sub-panel, click the Summary button to view history information at a glance instead of 
selecting each item to view.  
 
The navigation shortcuts provided help you create a new contact by typing it in or by importing the 
information from a vCard, or switch back to the Contact List view. As well, an Import facility is 
provided, to import bulk contact data from Salesforce.com, Outlook, ACT!, or other applications. 
 
The Contact list view provides powerful linking capabilities to related information. Clicking on the 
Contact name displays a detailed view of that Contact. Clicking on the Account name displays a 
detailed view of that Account.  
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4.5 The Accounts Module 
 
Figure 11 shows the Sugar Open Source screen with the Accounts module selected using the 
Accounts navigation tab:  
 

 
 

Figure 11: The Accounts Module 
 
The Accounts module provides a list of all or selected Accounts from a recent search. Each account 
in the list has a check box at the left, and at the bottom of the screen is a facility to update one or 
more field values for all selected accounts. 
 
The Account list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Account list is paginated if it contains more items than may be listed on the display. Controls are 
provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
account in the list displays the detail information for that account. Click the View Change Log link to 
view the old and new values for fields that track changes. The tracked fields include Assigned User, 
Member Organization assignment, Fax, Email Address, and Team. In the History sub-panel, click the 
Summary button to view history information at a glance instead of selecting each item to view. 
 
The navigation shortcuts provided help you create a new account, or switch back to the Account List 
view. As well, an Import facility is provided, to import bulk account data from Salesforce.com, ACT!, 
or other applications. You can assign accounts to other users and describe accounts by Type and 
Industry. 
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4.6 The Leads Module 
 
Figure 12 shows the Sugar Open Source screen with the Leads module selected using the Leads 
navigation tab:  

 
 

Figure 12: The Leads Module 
 
Leads are early contacts in the sales process. Once they have been properly evaluated and 
assessed, they may be converted into Contacts, with associated Opportunities and Accounts. 
 
They may be managed and tracked through their life-cycle using the Leads module. Leads may be 
assigned a Lead Source of Cold Call, Existing Customer, Self Generated, Employee, Partner, Public 
Relations, Direct Mail, Conference, Trade Show, Web Site, Word of Mouth, or Other. They have a 
status of New, Assigned, In Process, Converted, Recycled, or Dead.  
 
Leads may be duplicated by clicking on the Duplicate button as a handy way of creating a number of 
similar leads. Leads may also be converted by clicking on the Convert Lead button to Contacts, and 
optionally their related Account, Opportunity, and even Appointment. 
 
The Leads module provides a list of all or selected Leads from a recent search. The Leads list may 
be sorted by clicking on any column title which has the  icon beside it. Clicking on a column title 
when it is already the highlighted sort column reverses the sort order. Each lead in the list has a 
check box at the left, and at the bottom of the screen is a facility to update one or more field values 
for all selected leads. 
 
The Leads list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on any 
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lead in the list displays the detail information for that lead. Click the View Change Log link to view the 
old and new values for fields that track changes. The tracked fields include Assigned User, Team, 
Source, Status, Do Not Call flag, Office Phone, Email, and Email Opt Out. In the History sub-panel, 
click the Summary button to view history information at a glance instead of selecting each item to 
view. 
 
The navigation shortcuts provided help you create a new lead (from a vCard, or by simply typing it 
in), or switch back to the Leads list view. As well, an Import facility is provided, to bring in bulk lead 
data from Salesforce.com, or other applications. 
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4.7 The Opportunities Module 
 
Figure 13 shows the Sugar Open Source screen with the Opportunities module selected using the 
Opportunities navigation tab:  
 

 
Figure 13: The Opportunities Module 

 
Opportunities represent potential sales opportunities that you want to manage into becoming sales. 
You can change the values for the amount, the current sales stage and probability of closing. You 
can assign opportunities to other users. The Opportunities module provides a list of all or selected 
Opportunities from a recent search. The Opportunities list may be sorted by clicking on any column 
title which has the  icon beside it. Clicking on a column title when it is already the highlighted sort 
column reverses the sort order. Each opportunity in the list has a check box at the left, and at the 
bottom of the screen is a facility to update one or more field values for all selected opportunities. 

 
The Opportunities list is paginated if it contains more items than may be listed on the display, and 
controls are provided to go to the start or end of the list, or step to the next or previous page. Clicking 
on any opportunity in the list displays the detail information for that opportunity. Clicking on the 
account name for an opportunity links to the detailed information for that account. Click the View 
Change Log link to view the old and new values for fields that track changes. The tracked fields 
include Assigned User, Team, Type, Amount, Date Closed, Sales Stage, and Probability. In the 
History sub-panel, click the Summary button to view history information at a glance instead of 
selecting each item to view. The navigation shortcuts provided help you create a new opportunity, or 
switch back to the Opportunity list view. As well, an Import facility is provided, to bring in bulk 
opportunity data from Salesforce.com, or other applications. 



Sugar Open Source User Guide 
 

 
Section 4: Using Sugar Open Source     Page 32 

4.8 The Cases Module 
 
Figure 14 shows the Sugar Open Source screen with the Cases module selected using the Cases 
navigation tab:  
 

 
Figure 14: The Cases Module 

 
Cases are inquiries or problems associated with an account. They may be managed and tracked 
through their life-cycle using the Cases module. Cases may be assigned High, Medium or Low 
priority. They have a status of New, Pending Input, Assigned, Rejected, or Closed.  
 
The Cases module provides a list of all or selected Cases from a recent search. Each Case in the list 
has a check box at the left, and at the bottom of the screen is a facility to update one or more field 
values for all selected Cases. 
 
The Cases list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Cases list is paginated if it contains more items than may be listed on the display, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on the 
subject for any case in the list displays the detail information for that case. Clicking on the account 
name for a case links to the detailed information for that account. Click the View Change Log link to 
view the old and new values for fields that track changes. The tracked fields include Assigned User, 
Team, Account, Status, and Priority. In the History sub-panel, click the Summary button to view 
history information at a glance instead of selecting each item to view. 
 
The navigation shortcuts provided help you create a new case, or switch back to the Case list view. 
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4.9 The Bug Tracker Module 
 
Figure 15 shows the Sugar Open Source screen with the Bug Tracker module selected using the 
Bug Tracker navigation tab:  
 

 
Figure 15: The Bug Tracker Module 

 
Bugs are defects or features associated with a particular revision of a product. They may be 
managed and tracked through their life-cycle using the Bug Tracker module. Bugs may be assigned 
a priority of Urgent, High, Medium and Low. They have a status of New, Assigned, Closed, Pending 
Input, or Rejected. Each Bug also specifies a release. The drop-down list of choices for release is 
populated by the System Administrator using the Issue Tracker Administration option within the 
administration screens. Each Bug may also be assigned a resolution status of Accepted, Duplicate, 
Fixed, Out of Date, Invalid, or Later.  
 
The Bug Tracker module provides a list of all or selected Bugs from a recent search. Each Bug in the 
list has a check box at the left, and at the bottom of the screen is a facility to update one or more field 
values for all selected Bugs. 
 
The Bug list may be sorted by clicking on any column title which has the  icon beside it. Clicking on 
a column title when it is already the highlighted sort column reverses the sort order. 
 
The Bug list is paginated if it contains more items than may be listed on the display and controls are 
provided to go to the start or end of the list, or step to the next or previous page. Clicking on the 
subject for any Bug in the list displays the detail information for that Bug. Click the View Change Log 
link to view the old and new values for fields that track changes. The tracked fields include Assigned 
User, Team, Status, Priority, and Resolution. In the History sub-panel, click the Summary button to 
view history information at a glance instead of selecting each item to view. 
 
The navigation shortcuts provided help you create a new Bug report, or switch back to the Bug list 
view. There is also a New Bug data entry box for quickly entering a new Bug as it is reported.  
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4.10 The Documents Module 
Figure 16 shows the Sugar Open Source screen with the Documents module selected using the 
Documents tab: 
 

 

Figure 16: The Documents Module 
 
The Documents module allows you to attach files to create a document list for sharing with other 
users. The Documents module provides a list of all or selected documents from a recent search. 
Each document in the list has a check box at the left, and at the bottom of the screen is a facility to 
update one or more field values for all selected documents. For example, you might want to change 
the expiration date for several documents at one time. 
 
To create a document, click the Create Document shortcut. Browse to the file you want to attach. 
You can type a different name for the document or use the file name provided. Select a Category, 
Sub Category, Status, Publish Date and Expiration Date. You can define a revision number or 
version for the document. You can also type a description for the document. 
 
After a document is published, other users can download it and view it. To view a document in the 
Documents List, click the document name and then select the file name next to Download File. You 
can choose to either save or open the downloaded file. 
 
When documents change, you can attach a new revision of the file by the editing the document. 
Select the document from the Document List and click Create in the Document Revisions section. 
Select the changed file using the same name or a new file to replace the original file. Specify a 
revision number and click Save. You cannot change the Document name displayed in the Document 
List when you are adding a revision. The revised file is displayed in the Document List with the new 
revision number. 



Sugar Open Source User Guide 
 

 
Section 4: Using Sugar Open Source     Page 35 

4.11 The Emails Module 
Figure 17 shows the Sugar Open Source screen with the Documents module selected using the 
Documents tab: 
 

 
 

Figure 17: The Emails Module 
 
The Emails module provides a list of all or selected Emails from a recent search. Each Email in the 
list has a check box at the left, and at the bottom of the screen is a facility to update one or more 
values for all selected Emails. The Emails list may be sorted by clicking on any column title which 
has the  icon beside it. Clicking on a column title when it is already the highlighted sort column 
reverses the sort order. The Emails list is paginated if it contains more items than may be listed on 
the display, and controls are provided to go to the start or end of the list, or step to the next or 
previous page. Clicking on the subject for any Email in the list displays the detail information for that 
Email. The navigation shortcuts provided help you to create a new Email, or switch back to the Email 
list view and also to create or view Email Templates or view Archived Emails. 
 
You can create Emails and send them if the Email Options in My Account are set correctly. An 
administrator must provide this information for your particular environment. When you send emails, 
you can attach a file to the email. This file becomes saved as a Note related to your email. You can 
also start emails and then click the Save As Draft button and send it later. Click the Drafts shortcut to 
display your draft emails. When you create an Email Template, you can insert variables for 
information such as First Name, Last Name, address or email. Then, the saved template can be 
applied when creating an email for individuals or in an emailing Campaign. The variables can be 
filled by data from the Prospect records when the email is sent. Refer to the Campaigns Module for 
more information on creating an emailing Campaign for large groups of leads or contacts. 
 
You can format the body text in emails and email templates using the text formatting toolbar. 
Highlight the text and click buttons on the toolbar to apply standard formatting options such as font 
face, size, bold, italics, indentation and color. Additional buttons insert rules, hyperlinks, pictures, 
table and display the HTML source code. You can also click Edit Alt Text to specify the text that 
displays when an email client cannot render HTML code.  
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4.12 The Campaigns Module 
Figure 18 shows the Sugar Open Source screen with the Documents module selected using the 
Documents navigation tab: 
 

 

Figure 18: The Campaigns Module 
 
You can create campaigns to track and manage marketing campaigns and prospects. You can 
create a campaign and then create a prospect list. Then you can add prospects to the list by 
importing them from file (either CSV or TSV) or by selecting them from Contacts or Leads. Prospects 
contain all the contact information for each prospect. 
 
If you create an Email Campaign, an additional Email Campaign section displays at the bottom of the 
screen. You can specify the From Name and From Email Address and the date you want the email to 
be sent to the prospects. You must also select an Email Template created in the Email module. 
When viewing the campaign, an additional list displays the status of scheduled email campaigns and 
allows you to edit or remove email campaigns that are waiting to be sent. When you remove an email 
campaign from the Email Marketing list, it deletes all of the emails related to the campaign but does 
not delete the campaign. Status for email campaigns in the Email Marketing list can be either In 
Queue, In Progress or Sent. 
 
For email campaigns, you can also specify settings for a Tracker Redirect URL which contains a 
hyperlink in the email that goes to a Web page and Tracker Link Text which is the displayed text for 
the hyperlink. After the emails have been sent, the Tracker Count displays how many times the 
Redirect URL has been clicked by readers of the emails. 
 
The Campaigns module provides a list of all or selected campaigns from a recent search. Each 
campaign in the list has a check box at the left, and at the bottom of the screen is a facility to update 
one or more field values for all selected campaigns. For example, you might want to change the end 
date for several campaigns at one time. Clicking on a campaign displays details about the campaign.  
Click the View Change Log link to view the old and new values for fields that track changes. The 
tracked fields include Assigned User, Team, Start Date, End Date, Status and Type. 
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4.12.1 Creating an Email Campaign 
Overview 
1. Confirm with your system administrator that the outbound email process is configured to send 

email from your system as outlined in sections “5.2.1 System: Configure System Settings” and 
“5.2.20 Mass Emailing: Setting Up EmailMan.” 

2. Create an email template. 
3. Create a campaign. 
4. Create an email marketing record associated to the campaign. 
5. Create or select an associated prospect list 

• If the prospect list has no associated prospects, create or add prospects to the prospect list. 
6. The email campaign will now send the next time your scheduled EmailMan process executes.  

For testing purposes, you can force the EmailMan process to execute by hitting the URL:               
 
         http://<server>/<sugarcrm>/emailmandelivery.php?verbose=true 
 
By putting this URL in your browser and hitting enter, the queued email marketing campaigns will 
launch and send out emails.  You will see a list of the results in your browser. 
 

4.12.1.1 Creating a Prospect 

 

Figure 19: Creating a Prospect 
 
 
Prospects created in this screen are stand-alone records that are not attached to Contacts or Leads.  
These records are stored in their own table and completely separate from Contact and Lead records. 
 
If you plan to send emails to existing Contacts or Leads, you can skip this step. 
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4.12.1.2 Creating a Prospect List 

 

Figure 20: Creating a Prospect List 
 
Prospect Lists are groupings of Contact, Lead or Prospect records.   
 

4.12.1.3 Creating an Email Template 

 

Figure 21: Creating an Email Template 
 
Email Templates can be used in both Email Marketing Campaigns and with standard outbound 
emails sent by any user in the system.  When creating an Email Template, you can specify both the 
HTML version as well as the text version by clicking on “Alt Text” and entering the text version in the 
box that opens.  Use Account, Contact, Lead or Prospect variables to personalize messages to the 
recipient.  
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You can wrap the Tracker URL link defined in the campaign around any text in the outbound email by 
simply putting the keywords TRACKER_URL_START and TRACKER_URL_END around the text 
you wish to be turned into a hyperlink. 

4.12.1.4 Creating a Campaign 

 

Figure 22: Creating a Campaign 
 
Use the start date and end date to indicate when a campaign takes place.  Note that these values do 
not impact the execution of an email marketing campaign.   Use the Campaign status to track the 
current planning stage of the campaign.  Like the start/end dates, the status value does not impact 
the execution of an email marketing campaign. 
 
In an email marketing campaign, the Tracker URL will be appended to the end of every outbound 
email message inside of Tracker Link Text.  When a recipient receives the email and clicks on the 
Tracker Link Text, that person’s browser will first visit the Tracker URL in order to track the click-
through and then will be redirected to the Tracker Redirect URL. 
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4.12.1.5 Creating an Email Marketing Record 

 

Figure 23: Creating an Email Marketing Record 
 
Choose an email template to be used for sending out campaigns.  Note that email marketing 
campaigns will only start executing if the start time is in the past.  Any email bounce backs will be 
sent to the From address defined in this record. 
 
As soon as a Prospect List is attached to the parent campaign record and the email marketing start 
date and time is in the past, outbound emails will be queued for delivery.  It is very important to note 
that every time the email marketing record is saved and the start date is in the past, the emails will be 
queued for delivery.  Be careful of this condition as you could inadvertently send duplicate emails. 

4.12.1.6 View Queued Outbound Marketing Campaign Emails 

 

Figure 24: Viewing Queued Emails 
 
All emails queued for delivery by the EmailMan process are displayed in this screen accessed by 
clicking on Admin and then on Mass Email Manager.  The EmailMan process will only attempt to 
send an email up to five times.  You can remove emails from the delivery queue by selecting the 
check box to the left of the email and then clicking “Delete.” 
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4.12.1.7 View Processed Outbound Marketing Campaign Emails 

 

Figure 25: Viewing Processed Emails 
 
All processed emails are displayed in the “View Processed Emails” screen.  Statistics such as the 
send date and number of times an email was attempted to be sent are tracked. 
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4.13 The Projects Module 
Figure 19 shows the Sugar Open Source screen with the Projects module selected using the 
Projects navigation tab:  
 

 

Figure 26: The Projects Module 
 
You can create Projects that contain Tasks. To create a Project, click the Create Project shortcut and 
type a Project name and assign the Project to a person. Then you can create tasks belonging to the 
Project. Tasks include details such as status, starting date, due date and measures of effort to 
complete the task. 
 
The Projects module provides a list of all or selected Projects from a recent search. Each Project in 
the list has a check box at the left, and at the bottom of the screen is a facility to update the Assigned 
To value for all selected Projects. The Total Estimated Effort column in the Project List View is the 
sum of all Project Tasks' estimated effort. The Total Actual Effort column in the Project List View is 
the sum of all Project Tasks' actual effort. Projects can be searched from the global search box in the 
top-right corner of the application. 
 
The Projects list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Projects list is paginated if it contains more items than may be listed on the screen, and controls 
are provided to go to the start or end of the list, or step to the next or previous page. Clicking on the 
subject for any Project in the list displays the detail information for that Project. In the History sub-
panel, click the Summary button to view history information at a glance instead of selecting each item 
to view. For Project Tasks, click the View Change Log link to view the old and new values for fields 
that track changes. The tracked fields include Assigned User, Team, Status, Due Date, Start Date, 
and Percent Complete. 
 
The navigation shortcuts provided help you to create a new Project, or switch back to the Project list 
view and also to create a new Task or view all Project Tasks. You can link Projects to Contacts, 
Accounts, and Opportunities. 
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You can indicate a Project Task dependency by choosing a Project Task in the Depends On field. 
The Utilization field indicates how much time a user is supposed to dedicate their work hours towards 
the assigned task. Only one person can be assigned to a given Project Task. The Progress field is 
available for the user to update to indicate how far along a Project Task is. The Task Number can be 
used to uniquely identify a task by number and can be used instead of referring to a task by Name. 
The Order field can be used to indicate what sequence a list of project Tasks should be performed in 
which is useful for Project Tasks that do not have tasks with dependencies assigned to them. All 
Project Tasks must be assigned to a Project. However, a Project may be associated to one or more 
Contact, Account, or Opportunity. Project Tasks under the Project tab are separate from Tasks under 
the Activities tab. The Milestone flag can be used to signify that a Project Task is significant as some 
sort of milestone along the Project lifetime. 
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4.14 The RSS Module 
 
Figure 20 shows the Sugar Open Source screen with the RSS module selected using the RSS 
navigation tab:  

 
 

Figure 27: The RSS Module 
 
The RSS module manages RDF Site Summary (RSS) feeds. These feeds provide news or other web 
content that is syndicated by web sites which publish their content in this manner. Sugar Open 
Source has hundreds of RSS feeds available as it is supplied, and others may easily be added via 
the New RSS Feed data entry box to create your own custom news-gathering experience. Clicking 
on the RSS Tab opens the My RSS News Feeds screen, as shown in the figure above. This screen 
is assembled from all the feeds you have marked as your favorites, and shows the latest information 
being provided by those feeds. The shortcuts provided let you display the All RSS News Feeds 
screen, or return to the My RSS News Feeds screen. 
 
Each feed on the My RRS News Feeds screen has , , and  controls to the right side of their 
header bar, to promote (move higher within the list), demote (move lower in the list), or remove that 
feed from your list of favorites. Within the header bar for each feed, you can also click on the name of 
the feed to see a full list of the items of information available from that feed, or on the word Website 
to go to the website associated with that feed. Each item of information listed for a feed has a brief 
title for the item which is linked to the full story or content, and the time and date when that item was 
added to the feed. Simply click on an item to see the full content in a new browser window.  
 
On the All RSS News Feeds screen, a list of all or selected RSS News Feeds from a recent search 
displays. The RSS News Feeds list is paginated if it contains more items than may be listed on the 
display and controls are provided to go to the start or end of the list, or step to the next or previous 
page. Clicking on the Title for any RSS News Feed in the list displays the full set of information 
currently available from that feed. Each RSS News Feed also has a control to add or remove it from 
your list of favorites. 
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4.15 The Dashboard Module 
 
Figure 21 shows the Sugar Open Source screen with the Dashboard module selected using the 
Dashboard navigation tab:  
 

 

 
 

Figure 28: The Dashboard Module 
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There are four charts on the Dashboard display. Highlighted item 1 is a horizontal stacked bar chart 
of Pipeline by Sales Stage. Each bar shows the value of potential sales at each stage of the sales 
pipeline. Highlighted item 2 is a horizontal stacked bar chart of Opportunities by Lead Source by 
Outcome. It shows a stacked bar of the total opportunities for each lead source. Each bar is made up 
of multi-colored segments which represent the outcome proportions for that lead source. Highlighted 
item 3 is a stacked bar chart of Pipeline by Month by Outcome. Each bar shows the total sales 
pipeline for each month. Each bar is made up of multi-colored segments which represent the 
outcome proportions for the pipeline in that month. Highlighted item 4 is a pie chart of Opportunities 
by Lead Source. This shows a simple pie visualization of the proportion of total sales opportunities 
for each lead source. 
 
Each chart may be customized by clicking on the Edit button by the top right corner of the chart. This 
displays a small dialog area which permits you to specify parameters of the report, including (as 
appropriate): 
 

• The date range or year for data to be charted; 
• The user or users for whom data should be charted;  
• The Sales Stages to be charted; and 
• The Lead Sources to be charted. 

 
The dialog box for each chart may be closed by clicking on the Edit button again, or you may alter 
parameters and then click on the Select button to produce a chart from different data. You may right 
click on each chart to set its display quality, to zoom the image, or to print it (charts are produced 
using Flash technology). To copy a chart for inclusion in a document (as in the figure below) you 
must take a screen copy (such as by using Alt-Print Screen in Windows) and then crop the captured 
image in an image editor such as Photoshop.  
 

 
Figure 29: The 'Sales Pipeline by Sales Stage' Char t 

 
A remarkably powerful feature of the Dashboard is that the charts allow for drilling down into the 
actual underlying data. This means that each distinctively colored area on every chart is actively 
linked to the set of opportunities it represents – simply click on an area to see those opportunities. 
For performance, their data sources are not automatically recalculated each time the Dashboard is 
displayed. To recalculate the data source for a given chart, simply click on the Refresh button 
associated with it (beside the Edit button). 
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5.0 User Profiles and System Admin  

5.1 My Account 
 
To access your own user profile screen, click the My Account link (see highlighted item 1, on Figure 
23 below) that appears at the top right of your screen whenever you are logged in to the system. 
Note that an Admin link next to it is only displayed for users with Administrator capability. The figure 
below shows the user profile screen. When Administrators view information on a user, a Duplicate 
button displays, which allows an administrator to duplicate an account record, and then edit it briefly, 
as a quick way of creating a new user.  
 
As discussed in the section on Managing Your Password, the Change Password button should be 
used periodically to change your user password.  
 

 
Figure 30: The 'My Account' Screen 

 
To edit the user profile, and change user preferences, click on the Edit button. This displays a screen 
which lets you define header information (such as First and Last Name, and User Name), User 
Settings, User Information (email address, title, department, and phone numbers), Address 

1 
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Information, Calendar Options, Email Options, and Edit Tabs. These groups of information are known 
collectively as the user profile.  
 
User settings include such items as a check box for Administrator capability (only users with 
Administrator capability are able to check this off), Assignment notifications (do you receive an email 
when you are assigned a responsibility), time format (AM/PM or 24-hour clock), a check box for 
gridlines on screen displays and a selector for the default preferred Currency.  
 
User information includes more details about the user and contact information. 
 
Email options contains information about your email server and must be specified correctly for you to 
send emails from the Emails module. This information is provided by an Administrator. 
 
The Calendar options include settings to share your free vs. busy time between your calendars in 
Microsoft Outlook and Sugar Open Source. This information is provided by an Administrator. 
 
Users can also modify what module tabs they see when logged in. Administrators define the master 
list of available tabs in the administration screens, but users can then modify their own tab list by 
removing any unneeded tabs. When Administrators edit users account, they can disallow tabs for 
individual users so that they are not available. 
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5.2 Employees Directory 
 
The Employees link displays a list of employees maintained by the administrator. The list displays the 
following values for each employee record: Name, Department, Reports to, Email, Phone and User 
Name.  
 
The Employees module provides a list of all or selected Employees from a recent search. The 
Employees list may be sorted by clicking on any column title which has the  icon beside it. Clicking 
on a column title when it is already the highlighted sort column reverses the sort order. 
 
The Employees list is paginated if it contains more items than may be listed on the screen, and 
controls are provided to go to the start or end of the list, or step to the next or previous page. Clicking 
on any Employee in the list displays the detail information for that Employee. 
 
The navigation shortcuts provided help you create a new employee or switch back to the Employees 
List view. When creating a new employee, you can add other contact information such as mailing 
address and employment status.  
 
Every User in the system has an attached Employee record. However, every Employee does not 
necessarily have a User record. Users that are not Administrators can view, search and select 
employees from the list. They cannot edit or add employees.  
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5.3 System Administration 
 
This section is intended for Administrators of Sugar Open Source. Administrators access an 
additional System Administration screen by clicking on the Admin link (see highlighted item 1, on 
figure below). Note that the Admin link is only displayed for Administrator users. This section 
describes the main areas and their settings in System Administration screen: 
• System 
• Studio 
• Bug Tracker 
• Mass Email Manager 
 

 
 

Figure 31: System Administration Module 
 

5.2.1 System: Configure System Settings 
Sugar Open Source can send users an email notification when they are assigned new 
responsibilities. Within the system administration functions, Configure Settings is used to enable, 
disable or configure the email notification system.  
 
Email notification settings include the subject line of the email to be sent, the user name and email 
address from which the email will be sent, as well as the Mail Transfer Agent (MTA) to be used. Note 
that the SMTP (Simple Mail Transfer Protocol) MTA should be selected if your system is running 
Windows. If your system is running Linux, either the SMTP or sendmail MTA may be selected, 
depending upon how your server is configured.  
 
If the SMTP MTA is selected, you must also specify the SMTP server name, and port number 
(default is 25) used to communicate with SMTP. If SMTP Authentication is selected via the checkbox 
provided, the SMTP User Name and Password to be used must also be provided.  
 
Configure Settings can also enable and disable the email notification system, and establishes the 
default notification setting for new users.  
 

1 
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You can also choose to enable self-service portal integration by selecting the check box. This allows 
Cases, Notes and other data to be accessed by an external customer self-service portal system. 
 

5.2.2 System: User Management 
User Management is used to create, remove, edit, and activate/deactivate users of the Sugar Open 
Source system.  
 
On this screen, an Administrator can search for a user, or click on a user name to select their profile 
to edit. Once a user profile has been selected, the Administrator may change the password, edit the 
profile, or duplicate the profile, using the methods described in the My Account section. Note that 
users must have a valid email address to receive email notifications.  
 

5.2.4 System: Role Management 
You can define Roles for groups of users to specify which modules the users have access to. An 
example use for Role is to create different module sets for Roles named Sales, Marketing, and 
Support. While the users assigned to the Support Role need access to the Bug Tracker module, the 
users in the Sales Roles do not. To create a Role, click the Create Role shortcut, type and name and 
select the modules to include for the Role and then save the Role.  
 
To assign users to a Role, you can view a Role from the Roles list and click the Role to see the 
modules included in the Role. Under the Users section, click the Select button to display a list of 
users. You can check the user names that you want to assign to this Role.  
 
When modules are not included, the subpanels related to the module that display on other module 
pages are also removed. 
 

5.2.5 System: Upgrade Wizard 
The Upgrade Wizard provides a quick way to upload and install upgrades to new versions, patches 
to existing versions, new language packs, and custom themes. These files are provided as .zip files. 
Before using the Upgrade Wizard, the config.php file for your installation must be writable.  
As administrator, you browse to select the .zip file for the upgrade and click Upload. Uploading the 
file queues the upgrade files for installation although no installation has yet occurred. Then, click 
Install to install the upgrade files. A list of files displays with checkboxes that you can deselect if you 
do not want specific files. Click Commit to complete the installation. The Upgrade Wizard 
automatically unzips and installs the files.  
A history of all upgrades that have been queued and installed displays in the list. You can uninstall 
language packs and themes using the Upgrade Wizard. Select the item to uninstall and click 
Uninstall. You cannot uninstall upgrades to new versions and patches.  
 

5.2.6 System: Sugar Updates 
When Sugar Updates is enabled, your system will periodically send SugarCRM, Inc. anonymous 
statistics about your installation. This information is used by SugarCRM, Inc. to track usage patterns 
and improve the product. In addition, administrators receive update notices when new versions or 
updates are available. You can check for updates automatically or manually by selecting the radio 
buttons and clicking the Check Now button. 
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5.2.7 System: Repair 
 
The Repair page includes options to upgrade and rebuild data from a previous version of Sugar 
Open Source into the right form for the current version of the program. The upgrade options include: 
 
Opportunities: Controls how currency fields within Opportunities are upgraded. This is needed to 
support an internationalized currency capability, which stores the currency type separately from the 
amount. Opportunities contains the following:  
 

• Verify Amounts: Clicking on this button verifies that the values in the currency fields are valid 
(numeric only), and do not have any currency characters such as US, CDN, in the value 
portion of the field. Checking Include Closed Records will also verify the currency fields of all 
closed records. 

• Fix Amounts: Attempts to fix any invalid amounts as detected above by creating a valid 
decimal value from the current amount. This procedure will backup any amounts it modifies 
into a database field called amount_backup. Warning : If you perform this function and notice 
errors, do not perform it again without first restoring from the backup (via Restore Amounts, 
below) as it will most likely overwrite the backup with new invalid data. Checking Include 
Closed Records will also fix the currency fields of all closed records. 

• Merge Currencies: Merges multiple currencies into a single currency. If you notice that there 
are multiple currency records for the same currency, you may choose to merge them 
together. This will also merge the currencies for all other modules. For example, “US” and 
“U.S.” would be merged to a single currency;. 

• Update US Dollar Amounts: Updates the U.S. Dollar amounts for Opportunities based on the 
current currency rates. This value is used to calculate Graphs and List View currency 
amounts. This will apply the exchange rates stored in the Sugar Open Source system and 
modify all the US currency field values based upon the current rates. Checking Include 
Closed Records will also update the US dollar amounts of all closed records. 

• Restore Amounts: This will undo the Fix Amounts processing, by restoring the original value 
from the backup field. 

 
Rebuild audit: Checks and rebuilds your audit tables. 
Rebuild Extensions: Rebuilds extensions including extended vardefs, language packs, menus, and 
administration.  
Repair Database: Repairs your Sugar database based on values defined in vardefs. This applies to 
MYSQL databases only. 
Rebuild Config File: Rebuilds the config.php by updating the version and adding defaults when not 
explicitly declared.. 
 

5.2.8 System: Currencies 
The Currencies screen is used to define currencies other than the US dollar. For each new currency 
defined, the name, symbol (e.g. $), exchange rate to the US$, and code (such as CDN for the 
Canadian dollar) must be entered. Note that each user can select his default currency in the User 
Management screen. 
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5.2.9 System: Backups 
You can create a backup of your Sugar application files as a .zip file. Specify a directory that is 
writable by the same user as the Apache process. Type a file name for the .zip file including the .zip 
extension. Click Confirm Settings to confirm that backup can be performed. Then click Run Backup 
to create the .zip file of your Sugar application files. To backup your database information, refer to 
your database vendor’s documentation. 
 

5.2.10 System: Module Loader 
The Module Loader lets you upload custom modules so that they are included in the current 
installation. Custom modules are provided as .zip files. As administrator, you browse to select the 
.zip file for the module and click Upload. Uploading the file queues the module on the local server for 
installation. Then, click Install to install the module. The Module Loader automatically unzips and 
installs the custom module. A history of all modules that have been queued and installed displays in 
the list. You can also uninstall modules using the Module Loader. Select the module to uninstall and 
click Uninstall. 
 

5.2.11 Studio: Field Layout 
The Layout Editor lets you rearrange the fields and panels on the screens available within Sugar 
Open Source, to customize them to fit your needs.  
 
Begin by selecting the name of the file to customize. This can be a specific view from one of the 
system’s modules, such as the list view, detail view, or edit view, or a sub-panel-. Choose the file 
name from the drop-down box provided, and then click on the Select File button. If you are not sure 
what file to edit you can select the Edit in Place checkbox; this adds an edit icon  to all the editable 
screens throughout Sugar Open Source. Now go to the screen you want to edit, click on the  icon, 
and enter the screen layout editor to customize that screen layout.  
 
Within the field layout function, special shortcuts display in the Shortcuts Box:  

• Select File : Sends you to the screen first seen when entering the field layout function, to 
select a file to edit. If you select this shortcut when you are in the middle of editing a screen, 
edits on that screen are lost if not already saved.  

• Edit Fields : Within the Layout Editor, Edit Fields is a mode that let’s you drag and rearrange 
individual fields or their labels within the details panel. Select the item handle (the little 
square grey box) next to the field or label you want to move, and then click on the item 
handle where you want the field or label located. This moves the item from its previous 
location to its new location. If there was already a field or label at the destination the two 
items swap positions. Edit Fields also lets you move sub-panels. Moving sub-panels is the 
same as moving fields; select the source sub-panel handle and then click on the destination 
sub-panel handle, and the two switch locations.  

• Edit Rows : Within the Layout Editor, Edit Rows is a mode that allows the addition and 
removal of rows in the details panel. Pressing the  adds a row below the one currently 
selected, and pressing the  removes the row currently selected. This feature is named Edit 
Columns in List views. 

• Edit Labels : Clicking Edit Labels displays all the fields used on the page and their labels in 
the Toolbox in the shortcuts area. The labels are displayed in edit boxes so that you can edit 
one or more labels at once and then click Save. You can also click on a specific label in the 
page to view and edit a single label in the Toolbox and then click Save. 
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The Toolbox provides a workspace to add new fields and labels to a screen, to temporarily hold 
items that have been removed from a screen, and to discard items which are not needed. Its 
functions include: 

• Display HTML Code : To test this feature, select this checkbox and then move your cursor 
around the screen being edited. As the cursor passes over each field or label in the screen 
you can see the html that comprises it displayed as ‘Alt’ text in a floating box below the 
cursor. Note:  While this function can be informative it is very CPU intensive, and should only 
be used when absolutely necessary. 

• Add Field : Opens a dialog box which lets you specify the type of field you want to add and 
its name label. Click on the Add button to put your new field and its label in the Toolbox 
workspace, and close the dialog box. Next, to move your new field from the Toolbox to the 
screen, select its item handle and then click on the item handle where you want the field 
located. 

• Edit Fields : Displays the Edit Custom Fields functionality for creating new fields. Click Save 
Layout to save your changes before clicking this item. Changes are not saved when you click 
this item because you are leaving the page. 

• Staging Area : Drag items to the Staging Area while you are working with them. 

• Sugar Fields : Lists the fields that are not used in the page. Selecting a field adds it to the 
Staging Area. You may only drag items out of this area. 

• Sugar Bin : You can add items from the Sugar Bin to the Staging Area. Items that you left in 
the Staging Area when you click Save Layout appear in the Sugar Bin the next time you edit 
this page. You may only drag items out of this area. 

To remove a field, select its handle and drag it to the Staging Area. After you remove a field it is 
listed in the Sugar Bin so that it is easy to locate for later use. 
 
Use the Save Layout button to save changes while in the Layout Editor. To discard changes simply 
choose the Select File shortcut to work on another file, or exit the Layout Editor entirely. Remember 
to un-check the Edit in Place checkbox before you leave the field layout function, or all your screens 
will still have the  icon on them. 
 

5.2.12 Studio: Edit Custom Fields 
You can add custom fields to any module in Sugar Open Source. First, select the module in which 
you want to add or edit custom fields. Then you can define the field using Field Name, Field Label 
(the label displayed on the module), Data Type, Max Size, Required Field (indicated by asterisks for 
users), and Default Value. After saving a new field, you can view and edit information about the field 
in the Custom Fields list for the module. In Field Layout, you can place the custom field on the 
module page by dragging it to the new location, just like any other field. 

5.2.13 Studio: Portal 
The Portal Administrative function is used to add new Tabs and Shortcuts to Sugar Open Source, 
which can link to any website you choose. This is commonly used to include email, forums, or any 
other web-based application, allowing Sugar Open Source to become a single interface focus for its 
users.  
 
Using this administrative option performs a similar function to clicking on the Portal tab to select the 
Portal module, and indeed takes you to the Portal module. However note that an Administrator will 
initially see the Portal List screen, but other users will see the Portal home site (a configuration 
option).  
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All users have a set of shortcuts allowing them to Add Site, List Sites, or navigate to any site visible 
to them. Each user has shortcuts to all sites marked as Global sites, plus any Personal sites they 
have created. 
 
The Portal List screen may be reached by clicking on the List Sites shortcut. For an Administrator, 
this screen lists all sites - Global sites available to all users, as well all the Personal sites created by 
individual users for their own specific purposes. If you are not an Administrator, you will not see the 
Global sites listed on this screen, as you do not have the ability to change any of them.  
 
From the Portal List screen, you can delete one or more Portal sites by selecting the checkbox 
beside them, and clicking on the Delete button below the list of Portal sites. You can also edit a 
Portal site by clicking on its name, or preview its target website by clicking on the link to its URL.  
 
You can create a new Portal site by clicking on the Add Site shortcut. When creating a new Portal 
site, you may enter the name and website for the new Portal site, click to select if it is currently visible 
or not, and choose if it is Personal (viewable only by you), or Global (viewable by everyone). Note: 
Only Administrators have the option to create Global Portal sites. You may also choose to have the 
new Portal site placed on a new Tab, on a new Shortcut, or both. Note: Only Administrators have the 
option to place a site on a Tab – other users may only create shortcuts. On any new Tab created by 
the Portal function, the Shortcuts Box contains all the same shortcuts as are provided on the Portal 
Tab.  
 

5.2.14 Studio: Migrate Custom Fields 
You can migrate custom fields by exporting the custom field structure from one server and importing 
it on another server. Before importing a new custom field structure, it is recommended that you 
export the current custom field structure as a backup. When you import a custom field structure, 
details display to describe what changes will be made to the database. If you agree with the 
changes, click the Execute non-simulation mode link. Importing removes any previously defined 
custom field structures that are not defined in the imported .sugar file as well as any data stored in 
those custom fields. If you want to revert the import process, import the backup version of the 
structure you exported. 
 

5.2.15 Studio: Dropdown Editor 
The Dropdown Editor is a very valuable tool for the Administrator. It permits the values in all of the 
drop-down boxes in the system to be edited. The options presented to the user may be edited, 
existing options may be eliminated, and new options may be added. For example, when defining a 
new Account, in the Account Type field, the user must normally choose from a set of drop-down 
options, including Analyst, Competitor, Customer, Integrator, Investor, Partner, Press, Prospect, 
Reseller, and Other. By using the Dropdown Editor, this option set may be altered, with more or less 
options, and different option values.  
 
To use the Dropdown Editor, select a name of a drop-down list, from the drop-down list of their 
names (if that is not too confusing a statement). For example, account_type_dom is the second 
option on this list. If you select that option, and then choose the language US English (only those 
language packs which have been installed on your system will be available as choices), and click on 
the Select button, you will see a list of the Account Type options as given above.  
 
On each line of the list, you will see a number of controls on the right hand side. The up and down 
arrows controls allow you to promote or demote an option, to a higher or lower position on the list. 
The Edit and Del controls allow you to edit or delete the drop-down options, respectively. The Ins 
control will add a new drop-down option into the list above the item on the line you click on. 
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5.2.16 Studio: Configure Tabs 
Both system administrators and users can easily configure which tabs appear at the top of the 
application. In the Configure Tabs administration option, administrators can define which menu tabs 
will appear for all users.  
 
Users can then modify their own personal tab settings in the My Account screen. Any tabs that an 
administrator removes cannot be added back by a user. You can unselect the Allow users to 
configure tabs check box if you do not want them to make any changes. 
 

5.2.17 Rename Tabs 
You can rename and rearrange the tabs that display for all users. In the list of tabs, you can click on 
the edit controls on the right side of list to move the tab up or down in the order of display. You can 
also edit the name, delete the tab, or add a new tab to the list. Tabs are identified by a key and a 
value. 
 

5.2.18 Bug Tracker: Releases 
The Releases Administration function is used to maintain the options available in the Release drop-
down box displayed when reporting a new bug in the Bug Tracker module.  
 
Each Release entry consists of a release version, a status (Active or Inactive, where Inactive will 
remove it from drop down lists) and the order in which it is listed in the Release drop down list. 
 

5.2.19 Mass Email Manager 
You can manage mass email campaigns that have been created in the Campaigns module. Other 
users may create email campaigns containing a template email to large numbers of prospects. 
Depending on the send date the user assigns to the emails, the emails then wait in the email queue 
to be sent on the particular date. As administrator, you can monitor these emails as they are sent. 
You can also delete emails that are waiting to be sent. You can view information on each email such 
as Campaign, Recipient Name, Recipient Email, From Name, From Address, User Name who 
created the email, Send On date, Send Attempts, and In Progress status. The Mass Emailing Queue 
Manager only displays emails created through email campaigns and does not include emails created 
using the Email module. 
 
To delete an email that is waiting to be sent, click the check box next to the email and click the 
Delete button. Click Check All to select all the emails in the list. 
 

5.2.20 Mass Emailing: Setting Up EmailMan 
EmailMan processes emails that are scheduled to be sent from within Campaigns. The template 
emails are sent to the recipients from a PHP script that must be run on regular intervals to send out 
the emails at the appropriate time. The user can choose the email template from the Campaigns 
module as well as the sender name, sender email address (recommended to be no-reply@<your 
company.com>.or something similar), and the time and date to send the email.  
 
When an email is processed, a link is appended to the end of the email for recipients to opt out of 
receiving emails. This will link back to a page on the same machine as your Sugar instance.  
 
To use EmailMan, you must first correctly configure the email settings outlined in Section 5.2.1 
above. EmailMan uses the same email server connection settings. Notifications do not necessarily 
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have to be turned on, but the settings must be properly configured for recipients to properly receive 
emails.  
 
Second, EmailMan requires a scheduling program to run the PHP script. For Microsoft Windows, you 
can use the Task Scheduler. For UNIX, you can use cron. Examples for both are below. 
 

Setting Up the Mass Emailing Cron Job on UNIX 

As a root user, type the following command at the shell prompt, replacing the 'path-to-sugarcrm' with 
your own path to the Sugar Open Source installation directory and replacing the 'apache' with the 
proper username that the web server runs as (usually defaults to 'apache'):  
 
/echo "0,10,20,30,40,50 * * * * cd /<path-to-sugarcrm>; 
<path-to-php> ./emailmandelivery.php" | crontab -u apache/  
 
This will setup a cron job to check every 10 minutes for whether any emails need to be sent out. If 
any do, EmailMan will process the template and send an email out immediately to the recipient. 
 
For more information about how to specify different times for running the cron job, see the man page 
of cron: 
 
/man 5 crontab/ 
 

Setting Up the Scheduler on Microsoft Windows 

As a user with Administrator privileges, go to Start > Settings > Control Panel > Scheduled Tasks. 
Double-click on 'Add Scheduled Task'. When the Scheduled Task Wizard asks you for the program 
you want Windows to run, browse for the '/emailmandelivery.php/' file under your 'path-to-sugarcrm' 
directory. Continue with the rest of the Wizard, making sure you click on the 'Daily' option when 
asked when to perform this task. 
 
Before you click on the Finish button for the Scheduled Task Wizard, check the box that says, 'Open 
advanced properties for this task when I click Finish.' A new dialog box displays after you click Finish. 
Click on the 'Schedule' tab and then on the 'Advanced' button. Check the box for 'Repeat task' and 
specify every 10 minutes with a duration of 24 hours. 
 

5.2.21 Calendar Information: Sharing Free/Busy Info rmation with 
Outlook 
 
You can specify settings in Outlook so that the free/busy information from the Outlook calendar for a 
user is shared with the user’s Calendar in Sugar Open Source. The settings must be configured on 
each user’s computer. 
 
In Microsoft Outlook, select Tools > Options. Then click the Calendar Options button and then click 
Free/Busy. Select the Publish at my location checkbox and enter the path for the Sugar email 
account information following the syntax: 
 
http://servername/sugarcrm/vcal_server.php/type=vfb&source=outlook&email= 
myemail@servername.com 
 
where ‘myemail@servername’ is the email address specified for Email Options in the user’s My 
Account page in Sugar Open Source. On the My Accounts page in the Calendar Options, the URL 
for publishing free/busy information is displayed in Your Publish URL. 
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For Search location, enter the path for the Outlook account information, such as: 
 
http://servername/sugarcrm/vcal_server.php/type=vfb&source=outlook&email=%NAME%@%SERVE
R% 
 
where %NAME% and %SERVER% are Outlook replacement variables to construct the email 
address. 
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6.0 Information Import and Export  

 
One of the most important aspects of any CRM software is getting the data from your last CRM 
system moved across into the new one, and getting the data out of your new CRM system for use in 
other applications. Note that this should typically only be done by a system Administrator.  
 
Sugar Open Source supports the importation of various kinds of data from several different popular 
contact managers and full CRM systems: 

• Accounts may be imported from Salesforce.com, from ACT!, or from most other systems via 
a custom mapping;  

• Contacts may be imported from Salesforce.com, from ACT!, from Outlook, or from most 
other systems via a custom mapping;  

• Leads may be imported from Salesforce.com, or from most other systems via a custom 
mapping; and  

• Opportunities may be imported from Salesforce.com, or from most other systems via a 
custom mapping. 

 
 

6.1 Importing Accounts and Contacts 
 
Importing Contacts into Sugar Open Source is fairly straightforward. First you use your old CRM 
application or contact manager to export the data into a Comma Separated Values (.CSV) file format. 
Then you use the import function within the Contacts module (accessible via the Navigation 
Shortcuts Box) to import the data. If a Contact record is imported which refers to an unknown 
Account, then a new record is automatically created for an Account of that name.  
 
One thing to watch, however, is that when Account records are created automatically in this fashion, 
they are essentially empty – they have associated contacts, but no address or telephone information 
is recorded. Because of this, you should typically import your Account data first, creating the records 
complete with address and telephone information (plus perhaps Account Type and lots of other 
information, depending on your old CRM system). This avoids creating rather empty Account 
records, and having to manually add the rest of their information later. 
 
See the sections below for exact steps on exporting and importing Contacts and Accounts. 
 

Exporting Contacts from Your Current Contact Manage r 
This example uses Outlook 2003 for exporting contact manager data. Other systems tend to work in 
similar ways. 

1. Under the File menu, select Import and Export. The Import and Export Wizard dialog box is 
then displayed.  

2. Select the action Export to a file, and click the Next button. 

3. Choose to create a file of the type Comma Separated Values (Windows), and click on the 
Next button. 
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4. Select an Outlook folder from which to export – typically your contacts folder - and click the 
Next button. 

5. Enter the filename and directory location for the exported file to be created, and click the 
Next button. 

6. Confirm your intention to export this file by clicking on the Finish button.  

7. The CSV file is then created by Outlook 2003. You can view the file easily, using Microsoft 
Excel or a simple text editor, to confirm that the data you intended has been exported. 

 

Importing Accounts 
If your Account data is coming in from another CRM system, then typically that system understands 
the distinction between a Contact and an Account – that one Account can have multiple Contacts – 
and has separate data for each. If, however, your data is being imported from a simpler contact 
manager – such as Microsoft Outlook, then the only data available is Contact data, and you will have 
to be a bit creative to avoid a lot of manual data entry as described above.  

If you are importing Account data from a full CRM, proceed now to step 5. If you only have exported 
contact data, and need to massage it to act as Account data to be imported, perform steps 1-4 
below: 

1. Copy your exported Contacts.csv file, and call the copy Accounts.csv. 

2. Edit the Accounts.csv file using Excel. First, sort the file on the column which contains the 
Company name.  

3. Now the more complex part: As you scroll through your data, sorted by Company name, you 
will see successive records which have the same company name, because there is more 
than one Contact from that Account (in Sugar Open Source terminology). To avoid multiple 
copies of the same Account within Sugar Open Source, you need to delete these duplicates. 
And to make sure that the best information is attached to the Account record, you should 
retain only the contact whose address and telephone information best represents the 
Account as a whole.  

Also look out for Company names which are similar but not identical due to inconsistencies 
in the way the Company name was entered – you should delete all duplicate records except 
the one with the Company name spelt exactly how you want to see it in Sugar Open Source. 

4. Now that you have a nice clean set of Account data, save the Excel file as a .CSV file type, 
and let’s proceed to import this Account data. 

5. Click on the import Accounts function within the Navigation Shortcuts Box of the Accounts 
module. 

6. Specify the Data Source: Select Salesforce.com, ACT!, or Custom – then click on the Next 
button to continue. For ‘massaged’ Outlook files where the field names no longer match 
exactly what is exported from Outlook, use the Custom data source. 

7. Upload the Export File: Use the Browse button to locate the Accounts CSV data file, and 
then click on the Next button to continue. 

8. Confirm Fields and Import: This screen (see Figure 28 below) shows four columns of data. 
Column 2 (Header Row) is the key – this contains the names of the fields being exported 
from your old CRM or contact manager. Columns 3 and 4 show example data from the first 
two records you are about to import. Column 1 (Database Field) is where you come in – you 
need to use all of the drop-down box controls in this column to select the fields within Sugar 
Open Source into which each incoming Account field is imported.  

Spend some time with this, exploring the names of the incoming fields, and the names of the 
corresponding Sugar Open Source fields, until you are sure you have defined the optimum 
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mapping between them. If you are importing from Outlook, a particularly important field 
mapping to get right is to map the incoming Company field to the Account Name field within 
Sugar Open Source.  

9. When you are satisfied you have the field mapping right, click on the Import Now button, at 
the bottom right of the screen. Before you do this you may choose to click on the Save As 
Custom Mapping checkbox, and provide a name for this mapping so that it may be used 
again in future. 

10. The Import Results screen is displayed. It will summarize how many records were 
successfully imported, how many were skipped over, and the reasons they were skipped 
over. Below the summary are complete lists of all the data imported.  

11. You can now choose to click on the Undo Last Import, Import More, or Finished buttons. 
Click on the Finished button if you are satisfied with the results of the data import, or Undo 
Last Import if you want to go back and try again – usually to improve the field mapping.  

 

 

Figure 32: Confirm Fields and Import Screen 
 

Importing Contacts 
Now that you have a set of Account records with fully descriptive data, let’s import your Contact data: 

1. Click on the import Contacts function within the Navigation Shortcuts Box of the Contacts 
module. 

2. Specify the Data Source: Select Salesforce.com, Microsoft Outlook, ACT!, or Custom – then 
click on the Next button to continue. 

3. Upload the Export File: Use the Browse button to locate the data file exported by your 
contacts manager, and then click on the Next button to continue. 

4. Confirm Fields and Import: This screen (see Figure 28 above) shows four columns of data. 
Column 2 (Header Row) is the key – this contains the names of the fields being exported 
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from your old CRM or contact manager. Columns 3 and 4 show example data from the first 
two records you are about to import. Column 1 (Database Field) is where you come in – you 
need to use all of the drop-down box controls in this column to select the fields within Sugar 
Open Source into which each incoming Contact field is imported.  

Spend some time with this, exploring the names of the incoming fields, and the names of the 
corresponding Sugar Open Source fields, until you are sure you have defined the optimum 
mapping between them. If you are importing from Outlook, a particularly important field 
mapping to get right is to map the incoming Company field to the Account Name field within 
Sugar Open Source, so that Contacts are associated with the correct Accounts.  

5. When you are satisfied you have the field mapping right, click on the Import Now button, at 
the bottom right of the screen. Before you do you may choose to click on the Save As 
Custom Mapping checkbox, and provide a name for this mapping so that it may be used 
again in future. 

6. The Import Results screen is displayed. It will summarize how many records were 
successfully imported, how many were skipped over, and the reasons they were skipped 
over. Below the summary are complete lists of all the data imported – both Contacts, and 
any Accounts which were automatically created.  

7. You can now choose to click on the Undo Last Import, Import More, or Finished buttons. 
Click on the Finished button if you are satisfied with the results of the data import, or Undo 
Last Import if you want to go back and try again – usually to improve the field mapping.  

 

6.2 Importing Leads and Opportunities 
 
Leads and Opportunities are typically only tracked by a full CRM system, not a simple contact 
manager. If your old system is Microsoft Outlook or a similar contact manager, then you will have no 
data to import. If you are migrating from a full CRM system such as Salesforce.com, then the Lead 
and Opportunity data may be exported from that system and imported into Sugar Open Source in a 
very similar fashion to importing Contact data, as described above.  
 

6.3 Exporting Information 
 
Sugar Open Source has quite flexible data exporting capabilities. Essentially all of the Sugar Open 
Source modules have an export function, accessed by clicking on the Export link in the top left corner 
of the list portion of each list view screen, including all five types of Activities, Accounts, Contacts, 
Leads, Opportunities and Cases. 
 
In each case, a Comma Separated Values (.CSV) file is produced, which contains all the currently 
selected records from the module in use (not just those records currently displayed on the screen). 
CSV files can be opened by Microsoft Excel for viewing, or by Notepad, Wordpad, and other text 
editors – and can easily be parsed as input files by most software. 
 
A sample portion of a CSV file, exported from the Accounts module and viewed in Excel, is shown in 
Figure 29 below. You can see that essentially the entire database table of information is exported in 
the CSV file with column titles, including the Record ID (a long and largely incomprehensible string of 
letters and numbers used as a unique reference to each Account record) and other fields which 
Sugar Open Source uses internally.  
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Figure 33: CSV File in Excel 
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